Welcome to Issue 2 December 2018
For this issue we have suggested some topics to keep the
blues away as the cold days begin to set in for the Winter
months and as we love to hear the sound of Shutter Therapy
ringing in our ears, we hope you will enjoy it too.
In this issue we have introduced the Members Showcase this
is where the members submit 3 photos via email to Stuart or
Tom using the same settings as our PDI competitions to share
with other members just for the fun of it.
We have also included some Photoshop Tips which we hope
you will find helpful in the post processing workflow. One of
the best tips is to familiar yourself with the simple keyboard
shortcuts, so start with it and it will certainly be helpful over
all, and you won’t have to sit in front of the monitor any
longer than necessary.

Photoshop Tips
Photoshop is a vast program, packed with all
kinds of sophisticated tools and functions to
keep the professional photography world
turning. Whatever your level of experience
with the software, there are some quick and
easy tips you can take advantage of to
improve your experience-here are a few that
might be helpful.
A good start is to learn the keyboard shortcuts
which will quicken up your post processing
workflow this allows you to move seamlessly
between tools within the Photoshop toolbox
nearly every tool has a shortcut like B for
brush, V for the move tool, J for the
healing brush, S for the clone brush, H for
the hand tool and R for the rotate tool to
name a few. For instance holding the Shift
key while dragging and dropping a layer
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between two documents or images will place
the layer into the centre of the destination
document/image. If there is a selection in the
in the destination document/image, dropping
the layer while holding down the Shift key
will drop it into the centre of the selection.
The Photoshop Preferences can be accessed
very quickly using keyboard shortcut Ctrl K
(Mac: Command K) this allows you to
customise the interface and options.
If the brush tool no longer displays the the
size of the brush tip and instead displays the
cross-hair cursor, press the Caps Lock key to
turn it on/off the precision cursor.

Double-clicking on the Zoom tool will zoom
your document/image to 100% which is
where you can assess the quality of noise
reduction and sharpness. A press of
Ctrl/Command plus 1 will do the same and
alternatively a Ctrl/Command plus zero
will fit the image to the screen.
After zooming into a document/Image past
800% you’ll see the pixel grid appear. To
disable it, go to Show>View>Pixel Grid.
The keyboard shortcut to copy all existing
layers into a single layer and place it as a new
layer on top of the other layers is Ctrl Alt
Shift E (Mac: Command Option Shift E}.
When things go wrong while working with a
file, don’t worry, sometimes the best option is
to simply “revert” the file by selecting Revert
from the File menu or you can press F12.
In Photoshop CC (14.2 and newer) you can
unlock the background layer by clicking once
on the lock icon. If you have an older version
of Photoshop, the easiest way to unlock a
background layer is to hold Alt (Mac:
Option) and double click on the lock icon.

Adjustment Layers
Don’t just desaturate images ( by going to
Image>adjustment>desaturate)
instead
add a Black and White Adjustment Layer

(in the Layers panel) and use the six colour
sliders that control one of the six primary
colours in the image, to adjust the brightness
of each colour. Even better, click on the
“click and drag” icon then click on any area
of the image that you want to make darker or
lighter and drag left to make them lighter,
right to make them darker.
One of the most useful tools in Photoshop to
bring out hidden detail in the shadows and
highlights is the Shadow / Highlights
A d j u s t m e n t U n d e r- I m a g e
Adjustments>Shadows/Highlights)
Unfortunately you cannot apply it using an
Adjustment Layer. To apply it nondestructively first turn your layer into a Smart
Object, then apply the Shadows/Highlights
Adjustment.

Change the Number of Grid Lines in
Curves
By default, Photoshop displays only a 4x4
grid inside the Curves dialog box. To help
make more detailed tonal adjustments,
increase the grid to 10x10 by holding down
Alt (Win) Option (Mac) and clicking
anywhere inside the grid. Use the same to
switch back to a 4x4 grid later if you need to.

and reprocess it, as changes made do not affect the data and nothing is lost in making the
changes, unlike in a JPG file. This is non-destructive editing.

Should you shoot in RAW or JPG?
This is a question that has polarised opinion
in photographic circles for a long time. My
personal view is that “it depends”.

Converting a RAW file is another step in the computer processing regime but once mastered
does not take up much more time. However, I would say that it is not always essential. Using
your cameras settings to achieve a good exposure in the first place is key. Get to know your
camera, its manual settings, its ISO limitations, and other abilities and learn to make the
most of them. Some have custom settings that you can take advantage of. Not all cameras
are equal! I once had a compact camera that could save RAW images – but the length of time
to save to the card was almost 20 seconds and took up much more space on the memory card,
which rendered it impractical. It is true that RAW files take up more room on your memory
card and you will, as a consequence, be able to save less images.

The overriding reason for choosing RAW is
that the “processing” power (the “chip”) in
your camera that creates a JPG file is far
inferior to the processing power of your
computer when you “develop” the
unprocessed raw data – the RAW file. This
gives you more control on how your image
can be manipulated in Lightroom or
Photoshop. This is not unlike the difference
between sending your film off to be
commercially processed, or having your
own darkroom and taking care of business
yourself. What you also have to remember
is that with RAW files there is a “sidecar”
xmp file that contains information that also
needs to be saved. Some people create DNG
(digital negative) files that combine these
together. The main advantage of a RAW file
is that if you keep it, you can revisit the file

I will use RAW files when shooting “difficult” subjects – weddings – where perfection is
paramount and blown highlights are unacceptable. Also in studio work and similar
situations. But, when shooting football matches I have no desire to spend more time than
necessary on producing a gallery so rely on my camera’s features (it is a professional body,
after all!) and do limited post processing. This is not to say everyone would take that view.
Remember that newer digital cameras have upgraded needs for RAW conversion, and you
may need to download not only the latest version, but also upgrade your operating system.
In conclusion, learn to work with both options and then choose in a positive manner.
Happy shooting.
Carol White-Griffiths LRPS

Geoff’s Teasers,
What is the advantage of using camera equipped with a cropped image sensor.
A: Pictures taken have more resolution than those captured on a camera
without a cropped image sensor.
B:

Cropped sensors provide less image noise than alternative types of image
sensors.

C: The focal length on the camera lens increases at the telephoto end of the focal
length producing increased magnification of telephoto subjects.
D:

The focal length on the camera lens reduces at the wide end of the focal length for
better wide angle coverage.
Answer is at bottom of last page
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Start a Project
A Personal Photography project is a good way to bring structure to your way of thinking
and how to challenge one’s way to improve your skills and have fun doing it.
It’s best to keep things simple and doable, I would suggest maybe about 10-12 themes to
keep it flexible this allows you to overcome the times when you run into a barrier or bad
weather etc.
Here are a few varied suggestions for starters:The neighbourhood I live in: (Plenty of scope here)
Take a walk into a park or woodland: (Take time to be a visual storyteller)
Visit a Museum, anyMuseum: (You will experience the good feel factor and feel calmer)
Illustrate a song title: (The world is your oyster)
Create a silhouette self or otherwise: (A walk on the dark side)
Take a portrait or self portrait with either natural light or flash etc:
Limit yourself to one lens only for a week or a month or more:
Limit yourself to shoot in manual mode only: (A great way to teach yourself what the
buttons and settings do on your camera)
Take a still life as a subject using available light: (natural, torch. flash, etc)
Macro or close up subjects: (An interesting topic to undertake)
Food photography: (A challenge in improving lighting techniques)
Explore the kitchen and show everyday items in an unusual way: (An opportunity to push
the boundaries of imagination)
Should anyone be keen enough to take up the above it could make a good night
at the club between now and September 2019
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Why do I take what I take?
I tend to take a lot of photos sometimes,
because somewhere in the back of my
mind I think I might use the image one
day and most of the time I don’t. Then
along comes a challenge in the way of a
competition theme like the Disappearing
Technologies, (a very hard subject to

come up with some images). So after
searching through about 18 thousand
images I found nothing that would be up
to scratch, so I with my brother Tom
decided that a very good source for
subject matter would be the Science
museum. So on the first available Sunday
we went there with one thing in mind, to
take images that would be good
candidates for this competition. A big
challenge
with
so
many
fine
photographers in the within the club.
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We knew that if we went early enough we
could park pretty much outside, we could
see the queues forming for a ten o’clock
opening, we didn’t know what we were
going to take as it has been many years
since we went to the Science museum.
The Museum was full of interesting
exhibits, photography was welcomed
without
any
restrictions
and
after going round
some of the floors I
went back to where
the aeroplane was
hanging. I took
some 20 images
from
different
angles to try and
hide the cables
holding
the
aeroplane up but I
knew that I would
have to get rid of
some of these
cables in postproduction. but I knew that I had the basis
of the images that I wanted. I worked on
the image in photoshop to reduce the steel
cables, but the bottom of the image didn’t
look right. I decided that to hide this up I
would add some photoshop fog that gave
the image an atmospheric look and also
hide what I wanted to and made the
subject stand out.
So sometimes I take photos to enter
competitions.

Understanding your new Camera Menu settings
Cameras are so complex these days the first thing that I learn and I do use a lot is
whenever things go wrong within the settings menu I navigate to the reset factory
default settings, this then allows me to continue taking pictures in the Auto mode and I
am up and away taking pictures. Remember Auto means just that it will set the iso, the
white balance, shutter speed and aperture, I can then sort out other settings like
Jpeg/Raw Large or small image size, ISO setting, White Balance, this will also help you
to get to know how to set other
functions like
drive modes,
stabilisation, how to change is ISO
and White balance as the light
changes.
I use an auto setting, or P mode a
lot, if I want to take photos and not
waste time trying to set up a very
complex piece of equipment.
Having said that I can then set the
ISO and the plus / minus exposure
in a blink of an eye to correct the
final result. I always try and look
at the back of the camera to see the
result even if I have to try and find
a shady area or put my camera
under a cloth like my photography
jacket.
Do not be afraid to ask anyone if they can help, I have done this many times as I said
modem day cameras are very complex and a far cry from when all you had to think
about was the Cloud, Sea and Mountain setting on a ring on the front of the camera and
a fixed 125 @ F8. A lot of modern cameras have image effects, as an example High key,
Monochrome, Silky, Bleach Bypass and so on, my cameras are Panasonic Lumix and
they have around 44 different pre-set effects and I use them, especially the Monochrome
settings that alone there are settings for Rough Monochrome, Sepia, Dynamic
Monochrome, or just Monochrome, Silky Monochrome, that is five different photos all
with a touch of a button or dial, the final result can be very surprising.
When taking photos look at the back of the camera and see how they look could it be a
bit darker, a bit brighter, this is when the Histogram is beneficial. Take several images
with different settings if you can, it will be worth it in the long run.

MOTIVATION
I find the best way to get motivated and
have a feeling of achievement is to do a
photographic project.
The benefits of doing a photography
project is that you can focus on the
shooting, plus you have an instant place to
start and not waste time thinking where do
I go today, what do I shoot?
I also find that a project encourages me to
do more photography because I am
thinking more about the images and the
project as a whole Sometimes ideas will
suddenly pop into my head, this is always a
good time to write it down for future use.
Having a project allows me be more
creative as I start to think about the next
shot, angle and what lens to use this will
also give me a sense of accomplishment.
The hardest thing to do is to choose a
subject and believe me there are endless
choices and endless ways to shoot it. It is
also a good idea to have a photographic
buddy to go out with and bounce off ideas,
(I usually go with Tom) and also pick a
subject that is easily accessible.
At the moment I have three projects that are
in progress, I have my Art Deco project
[London is filled with Art Deco]. I have
my 1 in 4 project all about mental health
with one of the largest mental health
hospital in the UK (Bethlem) in
Beckenham and only 30 minutes from
where I live. These two projects are very
accessible and require an approach that is
very different on style and technique, it will
be my choice to shoot in colour or Black
and White.
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I might even impress myself with the
results.

How Did I Do This

My third and hardest project is the Dragon
flies of the Gambia, I have chosen this as
my location as I normally visit the Gambia
at least once a year. It is not on my door
step, its 2961 miles away and also a much
higher cost to achieve my goal. Once again
a very different technique and special
equipment and a whole lot of new skills
some of what I think I already have or think
I have time will tell, so get a project to
develop up and see where it can take you
LRPS, ARPS maybe, good luck everyone.

Redesigned for a modern touch
experience, Photoshop CC
on iPad will deliver the power
and precision of its desktop
counterpart. Photoshop CC
on iPad will let users open
and edit native PSD files
using Photoshop’s
industry-standard
image-editing tools and
will feature he familiar
Photoshop layers panel.
With Photoshop CC across devices,
coming first to iPad in 2019,
you will be able to start your work
on an iPad and seamlessly
roundtrip all of your edits
with Photoshop CC on
the desktop via
Creative Cloud.

This was taken 5 years ago in my garden, with my Grandaughter as the star of the
show “Multiplicity”, the plan was to have six Sophies’ dancing, running,
chasing the dog and running away from Nanny.
The camera used was an Olympus EM5 12-50mm (24mm-100mm) ISO 500, F8,
1/320sec in Manual mode and attached to a tripod, I took the first image with an
empty garden then cue Sophie to take her part using the width of the garden whilst
I quickly took 25 images.
I wanted to have all the images to be in separate layers for blending together, this
is quite easy in Photoshop go to menu File>Scripts>Load Files Into Stack then
attach a layer mask to each layer which is black/white in colour (White reveals
whilst Black conceals) The shortcut is D to set the foreground and background
to white and black and X switches between them. The first layer should be the
empty garden shot, all the other layers should be above and require to have a layer
mask. (If you are not familiar with layer masks I’d be quite happy to show
you this technique at any club night).

Members Showcase

©

©
6

2018 Alan Rollings

2018 Geoff Lamy

Members Showcase

©

©
7

2018 Cliff Knowles

2018 Stuart Burns LRPS

Members Showcase

©
8

2018 Tom Burns ARPS

The new Photo Insights magazine is now up and running and we hope you
are enjoying it. We aim to include a variety of articles covering Hints / Tips,
photography techniques, personal photography experiences and current or
future projects which hopefully will be inspiring and creative, plus any other
items of interest such as any exhibitions in the area or places of photographic
interest worth visiting.
We hope you take an interest in contributing articles, photographic story
telling and anything of photographic interest. The next issue will be in April
2019 and we would like to receive any copy between now and 27th March.
Merry Xmas and a Happy New 2019

Editors: Tom Burns ARPS
Stuart Burns LRPS

Contact details: tomphotofx@aol.com
stuartsphotos@btconnect.com

Before and After
Apart from the taking of pictures I’ve always enjoyed the post processing side of digital
photography, I was an early adopter of gear and software back in the early 1990’s and
for me it felt like I’d been turned into a magician with magic powers to change things.
Using a Wacom graphic tablet with an outstanding pressure sensitivity of the pen, it
opened up a different way of looking at photography especially when it was
incorporating Photoshop software plus extras.
The pictures opposite were processed in Adobe Camera Raw developer starting from
Raw or JPG images, With so much more data than a JPEG, RAW files open up more
possibilities during post processing. Correcting the white balance on a RAW file doesn’t
harm the integrity of the shot. Exposure errors can be corrected with more accuracy than
using a JPEG file. And along with making minor image corrections, RAW files can be
adjusted to settings that aren’t adjustable in the camera. For example, a photographer
can add more contrast to a RAW photograph by adjusting the highlights, lights, shadows
and dark areas of an image separately.
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Geoff’s Teaser = C
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